
LTspice Tutorial: Part 1 

The LTspice Tutorial below will take you through how to get started with LTspice®, the free circuit 

simulation package from Linear Technology. 
  
To download LTspice, go to the Linear Technology Home Page and click on the LTspice Download icon. 
You can either register to get notifications of updates, or just download the package anyway. If you do 

not register, you can still update the package as often as you like. 
  
We recommend you download LTspice XVII and not LTspice IV. LTspice IV is not updated 
  
Download the .exe file to a directory of your choice. 
  
Run the .exe file, accept the license agreement and install LTspice. 
  
LTspice should start automatically and place an icon on your desktop. 
  
Once in LTspice, click on Tools-> Sync Release to ensure you have the latest updates. It is worth 

repeating this step every time you use LTspice to ensure you have the latest models loaded. 
  
LTspice has models of most of the LTC analogue part numbers as well as 'jigs' to get you started. 'Jigs' 

are ready made circuits including the desired component and all of the surrounding resistors, 
capacitors and inductors to enable you to immediately start evaluating it without having to place all the 

passives. 
  
It is advisable to create a separate directory to store your LTspice files so you do not overwrite the 

original jig files. 
  
To start, we are going to design a non inverting amplifier with a gain of 10 and a 1kHz 1V sinewave 

input and a load of 10k Ohms, based on the LT1012 op amp. 
  
Double clicking on the desktop icon brings up the page shown in FIG 1. 
  

 
FIG 1 

  

http://www.linear.com/


To bring up the 'jig' select File -> New Schematic then press the  icon and navigate to the 

component you need, then click 'Open this macromodel's test fixture', as shown in FIG 2 
  

 
  

FIG 2 
  
It should look like FIG 2a 
  

 
FIG 2a 

  



Save this file to your chosen directory. 
  
Then save the jig to your chosen directory. 
  
To open the datasheet for the part, right click on the part and Select 'Go to Linear website for 

datasheet'. 
  

  
Incidentally, I prefer a white background instead of grey. To change this go to Tools -> Control Panel 
then click on the Waveforms tab, select Color Scheme, click on the Schematics tab, then next to Select 

Items choose Background from the drop down menu. You can then move the Red Green and Blue 
sliders to pick a colour of your choice. 
  
We are going to edit this schematic to get a non inverting amplifier as specified earlier. 
  
The following shortcut keys allow you to edit any schematic in LTspice: 
  
<F5>            delete 
<F6>            copy 
<F7>            move component without wires attached 
<F8>            move components with wires attached 
<F9>            undo 
shift<F9>    redo 
<CTRL R>    rotates component (once it has been selected using <F7>) 
<CTRL E>    mirrors component (once it has been selected using <F7>) 
  
In addition to the commands above, the LTspice toolbar shown in FIG 3, allows us to insert 

components 
  

 
FIG 3 

  
In the schematic above, V1 and V2 are the +/-15V supply to the LT1012, so we will keep these. We 

also want to keep V4, the input signal as well as the op amp. 
  



Using the shortcut keys and the toolbar construct the schematic shown in FIG 4. It is worth noting that 
large areas of circuit can be deleted/moved/copied by selecting the appropriate <F> key, holding down 

the left hand mouse button and highlighting that part of the circuit. 
  

 
FIG 4 

  
Note that R1 and R2 are generic resistors with no value. To change the value of any component in 

LTspice, right click over the component to bring up the basic component properties. Holding down the 
<CTRL> key and right clicking brings up a more comprehensive list of properties. To change the values 

of R1 and R2, right click over these components and type 10k into the Resistance box. 
  
We now need to modify V4 to give us a sinewave of 1kHz. Right click over V4 and it will bring up the 

box shown in FIG 5 
  



 
FIG 5 

This dialogue box allows us to choose whether V4 is a dc voltage, Pulse, Sinewave, Exponential, Single 

Frequency FM or Piece Wise Linear waveform. The only parameters we need to modify are Amplitude 
(change this to 1) and Freq (change this to 1k). 
  
Incidentally, LTspice recognises 'M' to mean 'milli' so setting the frequency to 1M will produce a 
sinewave of 1milliHertz. If a frequency of 1MHz is desired, either use 1000k or 1MEG. 
  
Click OK to return to the schematic. 
  
We now need to add some labels to the circuit. This makes probing much easier. Click on the Label 
icon and add IN to the input and OUT to the output. Your circuit should look like FIG 6 
  

 



FIG 6 
  
To set the simulation conditions, click on Simulate -> Edit Simulation cmd and enter 10ms in the Stop 
Time box as shown in FIG 7 
  

 
FIG 7 

  
We are now ready to simulate the circuit. Save the file first. 
  
Click on the Running Man symbol in the toolbar as shown in FIG 8 
  

 
FIG 8 

  
The screen will divide showing the schematic in one half and the simulation window in the other. Click 
the mouse anywhere in the schematic window. Moving the mouse over certain parts of the circuit will 

highlight either a voltage probe or current probe. 
  

  

  

 
Voltage Probe 

  

 
Current Probe 

  



Hover the mouse over the output of the op amp and click when the probe appears to show the voltage 
at the output of the op amp. Repeating this process at the input of the op amp shows the input 

voltage. The resultant waveform screen should look like FIG 9 
  

 

FIG 9 

  
LTspice Tutorial 1: Other Tips and Tricks 
  
All circuits must have a ground. 
  
Drawing a wire straight through several components is an easy way of connecting the components in 

series. 
  
If you need to plot a differential voltage, move the mouse to the positive node of the voltage to be 

measured and once the probe symbol has appeared, left click the mouse then drag the probe to the 
negative node. The probe colour will change from red to black. Release the mouse and the differential 

voltage will be displayed. 
  
If you want to plot multiple waveforms with respect to a node other than ground, navigate to that 
node, right click the mouse and the following list of options will appear: 
  

 
  
Select 'Mark Reference'. Thereafter all plots will be referenced with respect to that node. 
  
Sometimes it is convenient to have 2 plot panes, especially when comparing 2 voltages of very 
different amplitudes. To create multiple plot panes, move the mouse to the plot pane, right click and 

select Add Plot Pane. Left clicking on a specific pane loads the probe results into that pane. Left clicking 
on the waveform icon (eg V(out)) and dragging the icon to the other pane, moves the waveform to the 

other pane. 
  



To remove a waveform from the plot pane, hit the <F5> key and delete the appropriate waveform logo 
at the top of the plot pane. As with the schematic editor, the <F9> key undoes the last action 

performed in the plot pane. 
  
Holding down the ALT key and left clicking over a wire plots the current in the wire. 
Holding down the ALT key and left clicking over a components displays the instantaneous power in that 
component. 
  

  
The latest version of LTspice (LTspice XVII) allows the use of multiple monitors, so the schematic can 

be displayed on one monitor, while the plot results are displayed on a second monitor. Right click in 
the Schematic Window and select 'Float Window'. The Schematic Window can now be moved between 

screens. The same can be done with the Plot Window. 
  
The toolbar can, however, only address non floating windows, so the Running Man symbol is greyed 

out when windows are floating. To run the simulation, select the Schematic Window, right click then 
select 'Run'. 
  

LTspice Tutorial: Part 2 

So we have learned how to enter a schematic in LTspice®. This LTspice tutorial will explain how to 

modify the circuit and apply some different signals to it. 
  
To save you constructing a new schematic, download this file: 2nd order Butterworth low pass filter. 

The circuit is shown in FIG 1 
  

 
FIG 1 

  
Note the voltage source is missing. To test the frequency response of the filter we could apply a 

sinewave input to the circuit and measure the amplitude of the output, then change the frequency of 

http://www.simonbramble.co.uk/lt_spice/lt_spice_files/2nd_order_butterworth_lp.asc


the sinewave and repeat the process. Or we could apply an ac sweep to the input and get a plot in the 
frequency domain instead of the time domain. 
  

To add a generic voltage source go to 'Add Component' by clicking on the  symbol and this should 
bring up the menu as shown in FIG 2 
  

 
FIG 2 

  
Scroll to the far right and add a 'voltage' and place it in the circuit. 
  
To implement an ac sweep, right click over the voltage source and select advanced to display the 

following: 
  



 
FIG 3 

  
Keeping the Function selections as 'None' enter a voltage in the Small Signal AC analysis box. Enter an 
amplitude of 1V then click OK. 
  
We now need to configure the simulator to perform the ac sweep. 
  
In the schematic editor, click on Simulate -> Edit Simulation cmd then click on the ac analysis tab. 

Enter the parameters as shown in FIG 4 
  



 
FIG 4 

  
This sets the number of steps to be displayed per octave, with a start frequency at 10Hz and a stop 
frequency of 100kHz. Click OK and put the simulation statement anywhere on the schematic. The final 

circuit is shown in FIG 5 
  

 
FIG 5 

Save the file. 
  
Clicking on the running man symbol will run the simulation. Probing the OUT node will plot the 

frequency response of the filter, clearly showing roll of above 1kHz. The phase response of the output 
with respect to the ac signal source is also plotted on the right hand y-axis. 



  
If we want to magnify a certain area of the plot, move the crosshairs to the desired part of the plot, 

left click the mouse and, holding it down, drag it over the area to be magnified. The plot will then zoom 
into that area. The coordinates of the crosshairs are shown in the bottom left hand corner of the screen 

and when a box is selected, these coordinates show the differential values of the box. Since this 

example is plotted in the frequency domain, the x-axis displays frequency. If the x-axis shows the time 
domain, the coordinates show time and when a box is selected the coordinates show differential time 

and frequency. 
  
Hitting the <F9> key undoes this action. 
  
If you want to zoom in or out when in the schematic window, use the Zoom In and Zoom Out symbols 

on the menu bar. Alternatively the jog wheel on your mouse performs the same function. Holding down 
the left mouse button and moving it over the schematic allows you to pan over the circuit. 
  
Hitting the space bar auto-sizes the schematic window. 
  
The x-axis and y-axis settings can be changed by moving the crosshairs over the desired axis and left 
clicking the mouse. 
  
To check the roll off characteristics of the filter, we need to display the cursors. Move the mouse to the 
'Vout' logo at the top of the plot pane and right click. This brings up a menu to enable us to select 

between 1 cursor or 2. Selecting a single cursor results in FIG 6. 
  

 
  

FIG 6 
  
(the shortcut for displaying the single cursor is to left click on the waveform icon V(out)). To select 2 

cursors, double click on the Vout icon. 
  
Moving the crosshairs over the cursor and left clicking the mouse enables us to move the cursor and 
measure the magnitude and phase response of the circuit in the results box. Closing the results box 

removes the cursors. If 2 cursors are selected differential voltages and phases can be displayed. 
  
We are now going to change the input signal from an ac sweep to a piecewise linear waveform. A 

piecewise linear voltage source consists of a series of voltages specified at certain instances in time 
with a linear change in voltage between them. 
  
Firstly, delete the Simulation command (.ac OCT 10 10 100k) 
  
Right click over the input voltage source to bring up the parameters dialogue box. Delete the ac 

amplitude and change the function button from (none) to PWL (piecewise linear). 
  
The setting box should look like FIG 7 



  

 
FIG 7 

  
The waveform above starts at 0V, stays at 0V until 1m after which it rises to 1V in 0.001ms. It stays at 
1V until 2ms, then falls to 0V in 0.001ms. 
  
In the schematic editors, click on Simulate -> Edit Simulation cmd and click on the Transient tab. Set 

the transient analysis to have a stop time of 5ms and click OK. 
  
Clicking the running man symbol brings up the plot pane as shown in FIG 8 
  

 
FIG 8 

  
Probing the IN and OUT nodes shows that although the Butterworth filter has excellent pass band 
performance, it is a poor filter to use if trying to maintain the shape of a pulse. 
  
A word of warning: If the PWL input starts at a non zero voltage, the Y axis of the plot pane will start 
at a non zero voltage. 
  



Run this simulation: 
LT1761 with Vin starting at 3.5V 
  
The input to this 3v3 linear regulator starts at 3.5V and ramps to 5V. Plot the output voltage. The Y 

axis of the plot pane starts at 3.2V, not 0V 
  
In the simulation below, the PWL input voltage has been changed to start at 0V instead of 3.5V. Now 

the Y axis of the plot pane starts at 0V: 
LT1761 with Vin starting at 0V 

 

LTspice Tutorial: Part 3 

What we have learned so far enables us to simulate most designs. This LTspice Tutorial digs deeper 

into circuit analysis with LTspice®. 
  
FIG 1 shows the jig of the LTC3878 external FET buck converter with a resistive load of 80mOhms. It 

can be downloaded here: LTC3878 buck converter 
  

 
FIG 1 

  
Running the simulation shows the output settles at 1.2V. Right click on the plot pane and select Add 
Plot Pane. In the schematic window hold down the ALT key and left click over the resistor Rload. This 

will plot the instantaneous power dissipation in the plot window as shown in FIG 2 with the units on the 
y axis. 
  

 

http://www.simonbramble.co.uk/lt_spice/lt_spice_files/LT1761_non_zero.asc
http://www.simonbramble.co.uk/lt_spice/lt_spice_files/LT1761_zero.asc
http://www.simonbramble.co.uk/lt_spice/lt_spice_files/LTC3878.asc


FIG 2 
  
If it appears in the incorrect plot pane, left click on the plot icon and drag it to the correct pane. 
  
In the plot window, hold down the CTRL key and left click over the plot icon (circled above in FIG 2) to 

bring up details of the average power dissipation, averaged over the time span of the plot. Selecting a 
section of the plot zooms in on the waveform and repeating CTRL left click shows the average power of 

that subsection of the waveform. 
  
LTspice Tutorial 3: Generating the Efficiency Report 
To generate an efficiency report, from the menu bar select Simulate -> Edit Simulation cmd and select 
'Stop simulating if steady state is detected'. Rerun the simulation. Then click on View -> Efficiency 

Report -> Show on Schematic. The efficiency report will appear on the schematic, as shown in FIG 3. 
  
Note: the efficiency report can only be generated when there is only one voltage source (which is 

assumed to be the input) and either one current source or a load called Rload (which is assumed to be 
the load). 
  

 
  

FIG 3 
  
Repeating the above steps removes the efficiency report from the schematic. 
  
It is also worthwhile returning to Simulate -> Edit Simulation cmd and unchecking the box 'Stop 
Simulating if steady state is detected' 
  
LTspice Tutorial 3: Using Maths functions to Calculate Efficiency 
There is no reason why you cannot use the maths functions in LTspice to examine efficiency and 

indeed this is an effective way of measuring the efficiency of a multi output system. 
  
A behavioral voltage source gives an output voltage according to a mathematical function. If we set up 
a behavioral voltage source to produce a voltage equal to the product of the input voltage and input 

current, we can then plot the input power over time. Likewise we can set up a behavioral voltage 

source to produce a voltage equal to the output powers of each converter. We can then set up a 
behavioral voltage source to produce a voltage equal to the ratio of output power to input power that 

then gives us a real time efficiency figure. 
  
Consider the circuit in FIG 3a. This is a simple circuit consisting of two 5V linear regulators driven from 

a 10V input, each providing a load current of 10mA. B1 is a behavioral voltage source whose output 



voltage is equal to Vin * Iin. B5 and B2 produce voltages (P1 and P2) equal to the output powers of 
each regulator. B3 outputs a voltage equal to the function (100*(P1+P2)/Pin) - in other words the 

efficiency. 
  
Setting up behavioral voltage sources can be tricky. It is best to construct the main circuit first, run the 

simulation, probe the desired voltages and currents and see what LTspice calls each voltage plot. The 
behavioral components need to correspond with these plot names. 
  
The circuit of FIG 3a can be downloaded here: Behavioral Voltage Sources 
  

 
FIG 3a 

  

  
LTspice Tutorial 3: Simulating a Transient Load 

We are now going to add a transient load to the output via a switch. Click the  icon and select 'sw' 
and place the switch on the schematic. Add the extra load components as shown in FIG 4, including a 

PULSE voltage source transitioning from 0V to 5V at 1.7ms of duration 1ms to control the switch. 
  

 
FIG 4 

  
The switch now needs to be defined. The best way of defining a switch is to go into the help files (by 

hitting <F1>) and searching for 'switch', then selecting Voltage Controlled Switch. This will bring up 
the dialogue shown in FIG 5 

  

http://www.simonbramble.co.uk/lt_spice/lt_spice_files/behavioral_voltage_sources.asc


 
  

FIG 5 
  
Highlight the line beginning '.model' and copy it. Back in the schematic editor, press the Spice Directive 
button and paste the text in as a Spice directive. Change the Spice directive to: 
  

.model MySwitch SW(Ron=1m Roff=1Meg Vt=1) 
  
to characterise the switch with an ON resistance of 1mOhm, an OFF resistance of 1MOhm and a 
threshold voltage of 1V. We don't need the other characteristics. 
  
Place the text anywhere on the schematic. 
  
To relate the switch to the .model we have just defined, right click on the switch symbol in the 
schematic window. In the Value field, enter MySwitch to relate the .model definition with the switch, as 

shown in FIG 6 
  



 
FIG 6 

  
Run the simulation. The output voltage and current through the extra resistor should look like FIG 7. 
  

 
FIG 7 

  
Now the above simulation has been conducted with ideal components. This is normally quite acceptable 
until it comes to measuring the impact of the effective series resistance (ESR) of the output capacitor, 

C2. The circuit is designed to support a 15A load, so large current surges will be flowing from the 
inductor to the output capacitor and any ESR in C2 will manifest itself as ripple on the output voltage. 

With a 1.2V output, this ripple could quite easily violate the output specification. 
  
Right clicking over capacitor C2 brings up the parameter table for the capacitor. We can either enter an 

ESR of our choice (a typical ESR of a tantalum capacitor is about 0.5Ohms), or we can press the Select 
Capacitor button to select one of the library capacitors in LTspice. LTspice contains libraries of many 

passive and active components and these can be selected by right clicking over the component of 
choice and browsing the libraries. 
  
Running the simulation with an ESR of 0.5 Ohms shows the effect on the output voltage. 
  



 
FIG 8 

  
Right clicking over most passive components allows us to add parasitic elements or select from the 
component tables already stored in LTspice. On a note of design, if the ESR is a problem, adding 

several capacitors in parallel reduces the effective ESR. A simulation with 6x100uF capacitors, each 
with an ESR of 0.5Ohms reduced the ripple from 329mV to 170mV. 
  
In the same way we can add a parasitic ESR to a capacitor, we can also add a series resistance to an 
inductor, just by right clicking over the inductor and entering a value in the Series Resistance box. 
  
It is easy to lose track of what parasitics have been included in the circuit, so pressing <CTRL> 

<ALT><SHIFT> H highlights on the schematic what components have parasitic elements. Press <F9> 

to undo. 
  
We are now going to look at simulating a transformer based design. Download the circuit in FIG 
9: LTC3872 flyback converter 
  

  

 
FIG 9 

  
This missing transformer can be made up of 2 inductors, together with a SPICE directive coupling the 
inductors. 
  

http://www.simonbramble.co.uk/lt_spice/lt_spice_files/LTC3872_flyback_converter.asc


Insert an inductor of 50uH in the primary and 2uH in the secondary. To make the two inductors into a 
transformer, we need to tell LTspice that they are linked via a mutual inductance, K. Insert a SPICE 

directive using the  button and insert the text 
  

K1 L1 L2 1 
  

This creates a mutual inductance, K1, between inductors L1 and L2 of value 1 (they have perfect 
coupling). 
  
You will notice that the dots have been added to the transformer. Make sure they have the correct 
polarity for a flyback transformer. Change the value of the primary inductor to 50uH and the secondary 

inductor to 2uH. 
  
You should now have a circuit similar to FIG 10 
  

 
FIG 10 

  
It is worth noting that the ratio of inductances on a transformer is equal to the square of the turns 

ratio. Thus the transformer above has an inductance ratio of 25:1, giving a turns ratio of 5:1. 
  
Also, if n inductors of the same value and wound on the same core are placed in series, the combined 

inductance is n2 x the value of a single inductor. 
  
If the transformer datasheet specifies a leakage inductance, this can be modelled as an additional 

primary inductor, but this inductor is not included in the SPICE directive detailing the mutual 
inductance. Thus any energy in this leakage inductance is not coupled into the secondary winding 

during the flyback cycle and manifests itself as ringing. 
 

LTspice Tutorial: Part 4 



This LTspice Tutorial explains how to import third party models into LTspice®. 
  
LTspice is not limited to simulating Linear Technology parts. Third party models can be imported into 
LTspice too. There are 2 types of model that can be imported into LTspice: 
  
.MODEL parts - these are simple components such as transistors and diodes 
.SUBCKT parts - these are more complex parts made up of simpler Spice parts (diodes, transistors, 

resistors etc) 
  
It is important to note that LTspice looks at the first line of the SPICE model to determine how the 

model should be handled. If the part is defined with a .MODEL statement, importing the model is 
handled one way; if the part is defined with a .SUBCKT statement, importing the model is handled in a 

slightly different way. Thus we could import 2 identical diodes, one defined with a .MODEL statement 
and one defined with a .SUBCKT statement and they are actually handled differently. LTspice looks at 

the model definition, NOT the component to determine how to import the part. 
  
.MODEL parts: 
To import a simple third party SPICE model into LTspice using the .MODEL directive , follow these 
steps: 

• Add a generic component to the schematic that represents the symbol of the SPICE model 
• Download the SPICE model into the same directory as the circuit you are simulating. 
• Make a note of the filename of the SPICE model, including the file extension. 
• Add a .include SPICE directive to the schematic that will use the model 
• Open the SPICE model and note the name of the model - this is the text immediately after the 

.MODEL directive and before the part designator (in the case below this is the text 
DI_SBG1030L). The SPICE model can be viewed from within LTspice. 

• Press <CTRL> then right click over the generic component and change the 'Value' field to the 
SPICE model name 

• Ensure the .include SPICE directive contains the exact filename of the SPICE model 
• Ensure the name of the generic component exactly matches the SPICE model name 

Here is an example of how to import a Schottky diode into a circuit. FIG 1 shows a simple circuit to 
measure the forward voltage drop across a diode. This can be downloaded here: Diode Test Circuit 
  

 
FIG 1 

  
Running the simulation shows the diode has a forward voltage drop of 653.2mV 
  
Remove diode D1 and replace it with the standard Schottky diode from the LTspice library. 
  
Download the SPICE model of the BAT 54 Schottky diode: BAT 54 SPICE model and save it in the same 
directory as the circuit in FIG 1. 
  

http://www.simonbramble.co.uk/lt_spice/lt_spice_files/Diode_Test.asc
http://www.simonbramble.co.uk/lt_spice/lt_spice_files/DI_BAT54.txt


Add the following SPICE directive to your schematic using the  symbol: 
  

.include DI_BAT54.txt 
  
To avoid spelling mistakes, use Windows Explorer to highlight and copy the filename including the 
filename extension (.txt). Paste the text after the include statement. 
  
Open the SPICE model file (using, say, Notepad) and note the name of the model (in this case it is 

DI_BAT54). Again, to avoid spelling mistakes, it is easier to highlight the model name and copy it. 
  
Press <CTRL> Right click over the Schottky diode symbol and paste the text DI_BAT54 into the Value 

field as shown in FIG 2. Do not put any comments in the Spice Model field. 
  

 
  

FIG 2 
  
The final circuit should look like FIG 3 
  

 
FIG 3 

  
Run the simulation. The forward voltage drop should now be 290mV. 



  
If you encounter errors, check the following: 
Has the SPICE file been loaded into the same directory as the simulation file? 
Is the part name the same as that specified in the SPICE model? 
Does the filename in the .include statement exactly match the SPICE model filename? 
  
It is also worth opening the SPICE model file from within LTspice and checking its contents. Some text 

editors can add formatting characters that confuse LTspice. 
  
.SUBCKT parts 
A similar procedure can be used to import more complex models. Follow the steps above, except when 
modifying the Component Attribute Editor (see FIG 2), ensure the Prefix attribute is marked as X (and 

not D as in FIG 2). 
  
We are now going to compare the performance of the LT6231, (215MHz low noise op amp) with the 

LM324 (low cost op amp). 
  
Download the circuit in FIG 4: Op Amp Test Circuit 
  

 
FIG 4 

  
Running this circuit shows the output falls from 1V at dc to 0.707V at about 2.77MHz. 
  
Now remove the LT6231 and replace it with a standard 5 terminal op amp. This is the 'opamp2' model 
in the Op Amps folder in LTspice. 
  
Download the LM324 model: LM324 model and save it in the same directory as the circuit in FIG 4. 
  
Make a note of the SPICE model filename (in this case it is LM324.txt). Add a .include SPICE directive 
in your schematic as follows: 
  

.include LM324.txt 
  

http://www.simonbramble.co.uk/lt_spice/lt_spice_files/op_amp_test_circuit.asc
http://www.simonbramble.co.uk/lt_spice/lt_spice_files/LM324.txt


Open the SPICE model and make a note of the SPICE model name (immediately after the .SUBCKT 
command). In this case it is LM324. 
  
Press <CTRL> Right click over the op amp symbol in the schematic and insert the model name into the 

Value field as shown in FIG 5 
  

 
FIG 5 

Ensure that the Prefix attribute is filled in with X. 
  
NOTE: The SPICE model of some simple components (e.g. Zener diodes) are defined as a SUBCKT. In 

this case, the Prefix attribute has to be 'X' and not 'D' to correspond with the .SUBCKT SPICE definition 
(and not a .MODEL definition). 
  
Creating a Quick Part Outline for 3rd Party SPICE models 
  
Once the SPICE model has been imported, an outline can be created for the part. Open the SPICE 
model in LTspice, move the mouse over the .SUBCKT line, right click and select 'Create Symbol'. A 

square symbol will appear showing the nodes of the SPICE model. 
  

  



 
FIG 5a 

  
Then select a new component (using the AND gate symbol) and in the dialogue box, the new 
component is stored under the [AutoGenerated] directory. 
  
Running the simulation shows the output falls to 0.707V at about 10kHz, showing the inferior 
frequency response of the LM324 over the LT6231. 
  
The final circuit is shown in FIG 6 
  

 
FIG 6 

  
SPICE models for many components that are needed with LTC devices can be downloaded here: 



  
SPICE Models for LTspice 

 

 

  

LTspice Tutorial: Part 5 

This LTspice tutorial discusses some of the more advanced tricks in LTspice®. 
  
The following topics are explained on this page: 
  
Shortcuts 
Tricks with Piecewise Linear (PWL) Sources 
Waveform Mathematics 

Stepping through parameters 

  
Shortcuts 
Rather than use the menu bar, the shortcuts in FIG1 are available to enable you to speed up schematic 
entry. 
  

 
FIG 1 

http://www.simonbramble.co.uk/lt_spice/ltspice_lt_spice_models.htm


  
Tricks with Piecewise Linear (PWL) Sources 
Piecewise Linear (PWL) sources enable the user to construct a waveform consisting of a series of 
straight lines. FIG 2 defines a voltage that starts at 0V, rises to 10V over 100ms, stays at 10V for the 

next 100ms then decays linearly over the next 100ms to 0V. 
  

 
FIG 2 

  
An alternative way of creating this PWL waveform is by defining each timing relative to the previous 
one. This makes it easier to move the waveform forward and backwards in time without having to 

recalculate all of the timings. FIG 3a and 3b shows how the above waveform is described using this 
technique. 
  

 
FIG 3a 

  

  



 
FIG 3b 

  
If this is cumbersome to read on the schematic, an alternative way of describing the waveform is 
shown in FIG 4. This is simply constructed by right clicking over the schematic text describing the PWL 

source and editing it. 
  

 
FIG 4 

This file can be downloaded here: Piecewise Linear Test 
  
The resultant waveform is shown in FIG 5 
  

 
FIG 5 

  
If you want to repeat the above waveform, LTspice allows you to edit the PWL text. To repeat the 

above waveform 5 times, right click over the PWL text and alter as shown in FIG 6. 
  

http://www.simonbramble.co.uk/lt_spice/lt_spice_files/piecewise_linear_test.asc


 
FIG 6 

  
Likewise, if you want the waveform to repeat forever, edit the PWL text according to FIG 7 
  

 
FIG 7 

  
LTspice also allows PWL waveforms to be read from a file. FIG 8 shows how to read the above 

waveform from a file called pwl_file.txt (and repeated 5 times) stored in the same directory as the 

schematic. The file format is shown in FIG 9. The first column specifies the time and the second 
specifies the voltage with the 2 columns separated by spaces or tabs. 
  

 
  

FIG 8 
  



 
FIG 9 

Similarly, the line 
  

PWL repeat forever (FILE=pwl_file.txt) endrepeat 
  
repeats the PWL waveform forever. 
  
Waveform Mathematics 
The icon V(pwl) in FIG 4 can be edited if needed. Thus if you want to see what V(pwl) looks like when 
multiplied by 3, simply right click over the icon and edit it as shown in FIG 10 
  

 
FIG 10 

  
This results in the plot shown in FIG 11 where the voltage has been increased by a factor of 3. 
  

 
FIG 11 

  
Indeed LTspice also recognises the variables 'time' and 'pi' and these can be used to manipulate the 
waveform accordingly. 



  
Stepping through parameters 
It is possible to perform multiple back to back simulations with different component values. FIG 12 
shows a simple non inverting amplifier. 
  

 
FIG 12 

  
By relabeling the feedback resistor value to 'R' (instead of, say, 10k) and putting it in curly brackets 

tells LTspice to treat the value as a variable. The .step command is then used to step R through 
different values. The .step command in this case steps the parameter R through the values 10k, 20k 

and 30k. Any number of parameters can be made into variables, however LTspice will run simulations 
on all the different combinations of each value. The above circuit applies a 100mV sinewave to an 

amplifier with gain of 2, 3 and 4. 
  
The resulting waveform at the OUT pin is shown in FIG 13. 
  

 
FIG 13 

  
To determine which waveform corresponds to which value of R, left click on the V(out) icon to bring up 
the cursor, then use the UP and DOWN arrows on the keyboard to move the cursor from one waveform 



to another. Right clicking over the vertical cursor brings up a dialogue box indicating which value of R 
has been used, as shown in FIG 14. 
  

 
FIG 14 

  
 

LTspice Tutorial: Part 6 

Creating LTspice® MOSFET models 
LTspice Tutorial 4 explained that there are 2 different types of SPICE model: those defined by the 
simple .MODEL statement and those defined by the more complex .SUBCKT statement. The .MODEL 

statement defines simple components such as diodes, transistors, MOSFETs etc with a list of 
predefined characteristics given to us by the writers of SPICE programs. The more esoteric components 

such as op amps, comparators etc were defined by a more general .SUBCKT model. 
  
When SPICE (not LTspice) was first created, the programmers gave the user a specific number of 

characteristics to define certain components. In the case of the MOSFET, this included the gate source 
turn on voltage, the transconductance, the resistance of the gate, source and drain connections etc. 

These are known as Level 1 parameters and define the most important parameters of the MOSFET. In 
later years, the MOSFET manufacturers wanted to further characterise their MOSFETs and not be 

restricted by the fixed list of parameters given to them by the writers of SPICE. They therefore turned 
to the .SUBCKT definition to allow them to expand the list of parameters. These are known as Level 2 

and Level 3 parameters and describe characteristics of the MOSFET not defined in the original SPICE 
definition of a MOSFET. However in making the model more complicated, they slowed down the 

simulation time of the MOSFET. 
  
LTspice therefore uses the simpler .MODEL statement to define the characteristics of a MOSFET. If 

using a 3rd party MOSFET model results in very slow simulation performance, it is probably because 
the model is defined using the .SUBCKT model and includes many parameters that are not necessary 

in getting an idea of the circuit performance. 
  
To create an LTspice model of a given MOSFET, you need the original datasheet and the pSPICE model 

of that MOSFET.  
  
The parameters needed to define a MOSFET in LTspice are as follows: 
  
Rg         Gate ohmic resistance 

Rd         Drain ohmic resistance (this is NOT the RDSon, but the resistance of the bond wire) 
Rs         Source ohmic resistance. 



Vto       Zero-bias threshold voltage. 
Kp –      Transconductance coefficient 

Lambda  Change in drain current with Vds 
Cgdmax  Maximum gate to drain capacitance. 

Cgdmin   Minimum gate to drain capacitance. 
Cgs       Gate to source capacitance. 

Cjo        Parasitic diode capacitance. 
Is          Parasitic diode saturation current. 

Rb         Body diode resistance. 
  
Rg, Rd and Rs are the resistances of the bond wires connecting the die to the package. 
  
Vto is the turn on voltage of the MOSFET. 
  
Kp is the transconductance of the MOSFET. This determines the drain current that flows for a given 
gate source voltage. 
  
Lambda is the change in drain current with drain source voltage and is used with Kp to determine the 
RDSon. 
  
Cgdmax and Cgdmin are the minimum and maximum values of the gate drain capacitance and are 
normally graphed in the MOSFET datasheet as Crss. The capacitance of a capacitor is inversely 

proportional to the distance between its plates. When the MOSFET is turned on, distance between the 
gate and the conducting channel of the drain is equal to the thickness of the insulating gate oxide layer 

(which is small) so the gate drain capacitance is high. When the MOSFET is turned off, the gate drain 
region is large, making the gate drain capacitance low. This can be seen on the plot of Crss. 
  
Cgs is the gate source capacitance. Although it changes slightly with gate source voltage, LTspice 
assumes it is constant. 
  
Is is the parasitic body diode saturation current. 
  
Rb is the series resistance of the body diode. 
  
The Fairchild FDS6680A MOSFET is defined in LTspice by the line 
  
.model FDS6680A VDMOS(Rg=3 Rd=5m Rs=1m Vto=2.2 Kp=63 Cgdmax=2n Cgdmin=1n Cgs=1.9n 

Cjo=1n Is=2.3p Rb=6m mfg=Fairchild Vds=30 Ron=15m Qg=27n) 
  
Note: the characteristics Vds, Ron and Qg are actually ignored by LTspice. These are only added to aid 

the user to compare MOSFETs. 
  
Therefore an example template MOSFET model is 
  
.model XXXX VDMOS(Rg= Rd=5 Rs=1 Vto= Kp= Cgdmax= Cgdmin= Cgs= Cjo= Is= Rb= ) 
  
We are now going to construct a MOSFET model for the SUM75N06 and SUM110N04 low ON resistance 
MOSFETs from Vishay 
  

SUM75N06 datasheet         Original SUM75N06 Model 
  

SUM110N04 datasheet         Original SUM110N04 Model 
  
The SUM75N06 has a moderately low ON resistance and a moderately low Qg, so is suitable as the top 
FET in a synchronous buck converter. The SUM110N04 has a high Qg but lower ON resistance, so is 

suitable as the bottom FET in a synchronous buck converter (see Buck Converter Design). 
  

SUM75N06: 

http://www.simonbramble.co.uk/lt_spice/lt_spice_files/SUM75N06.pdf
http://www.simonbramble.co.uk/lt_spice/lt_spice_files/SUM75N06.txt
http://www.simonbramble.co.uk/lt_spice/lt_spice_files/sum110n0.pdf
http://www.simonbramble.co.uk/lt_spice/lt_spice_files/sum110n0.txt
http://www.simonbramble.co.uk/dc_dc_converter_design/buck_converter/buck_converter_design.htm


Characteristic Source Value 

Rg 
another SPICE 

model 
1.5 

Ohms 

Rd SPICE model 
0 

Ohms 

Rs SPICE model 
25m 
Ohms 

Vto Datasheet 2V 

Kp Datasheet 75 S 

Lambda 
SPICE default 

value 
1 

Cgdmax 
Datasheet Crss 

curve 
1200pF 

Cgdmin 
Datasheet Crss 

curve 
150pF 

Cgs SPICE model 2000pF 

Cjo SPICE model 1200pF 

Is SPICE model 1pA 

Rb 
SPICE default 

value 
0 

Ohms 

  
The final SPICE model can be downloaded here: SUM75N06 LTspice model 
  

SUM110N04: 

Characteristic Source Value 

Rg 
another SPICE 

model 
1.5 

Ohms 

Rd SPICE model 
0 

Ohms 

Rs SPICE model 
0.86m 
Ohms 

Vto Datasheet 1.85V 

Kp Datasheet 180 S 

Lambda 
SPICE default 

value 
1 

Cgdmax 
Datasheet Crss 

curve 
3000pF 

Cgdmin 
Datasheet Crss 

curve 
900pF 

Cgs SPICE model 14.5nF 

Cjo SPICE model 4.9nF 

Is SPICE model 33.4pA 

Rb 
SPICE default 

value 
0 

Ohms 

  
The final SPICE model can be downloaded here: SUM110N04 LTspice model 
  
The SPICE models can then be testing using these test jigs: 
  
RDSon test jig 

http://www.simonbramble.co.uk/lt_spice/lt_spice_files/SUM75N06a.txt
http://www.simonbramble.co.uk/lt_spice/lt_spice_files/SUM110N04a.txt
http://www.simonbramble.co.uk/lt_spice/lt_spice_files/mosfet_test_circuit_rds.asc


To test the RDSON of the MOSFET import the model into the LTspice test circuit. Check the datasheet 
to see how the RDSOn has been tested. It will be characterised with a certain gate-source voltage and 

a certain drain current. 
  
Run the simulation. Probe the drain voltage. Probe the drain current. Edit the Drain current icon to 

read V(drain)/Id(M1). This changes one of the axes to read ON resistance. You may have to change 
the parameter Kp slightly to match the datasheet performance. 
  
Switching Time Test Jig 
To test the switching time of the MOSFET import the model into the LTspice test circuit. Check the 
datasheet to see how the switching times have been tested. They will be characterised with a certain 

gate drive voltage, gate drive resistance and drain voltage and the response time will be characterised 

when the drain current ramps to a certain level. 
  
Run the simulation. Probe the gate voltage. Probe the drain current. Zoom in on the rising edge of the 
gate/drain waveforms. Left click on the Drain current axis and rescale the axis to measure slightly over 

the current desired drain current. The timings can now be measured. Rise time is normally measured 

over 10% to 90% of the desired voltage swing. You may have to change the model capacitances 
slightly to meet datasheet performance. 

LTspice is a registered trademark of Linear Technology Corporation 

 

http://www.simonbramble.co.uk/lt_spice/lt_spice_files/mosfet_test_circuit_qg.asc

